Copyright 2006 Corel Corporation. All rights reserved.

Corel Paint Shop Pro Photo XI Reviewer’s Guide

Protected by U.S. Patents 5652880; 5347620; 5767860; 6195100; 6385336; 6552725; 6657739; 6731309; 6825859; 6633305; Patents Pending.

Product specifications, pricing, packaging, technical support and information (“specifications”) refer to the retail English version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL’S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, CorelDRAW, MAIL, Painter, Paint Shop Pro, Picture Tubes, WinZip, and WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada, the U.S., and/or other countries.

Apple is a registered trademark of Apple Computer, Inc., registered in the United States and other countries. Microsoft, DirectX, Outlook, and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. The NASDAQ Stock Market is a registered trademark of The NASDAQ Stock Market, Inc.
## Contents

1 | Introducing Corel Paint Shop Pro Photo XI  ...................1

2 | Customer Profile ........................................................3
   Photo Hobbyists .............................................................................. 3
   Photo Project Enthusiasts ................................................................. 3
   Professional Photographers ................................................................. 4
   Office Workers ................................................................................... 4

3 | What’s included with Corel Paint Shop Pro Photo XI? ..5
   Applications ...................................................................................... 5
   Content ............................................................................................... 5
   Printed Documentation ........................................................................... 5
   Electronic Documentation ...................................................................... 6
   Minimum System Requirements ......................................................... 6
   Recommended System Configuration ................................................ 6

4 | Top Features .....................................................................7
   Photo Organization Built Right In .................................................... 7
   Essential Photo Tools For Everyday Jobs ............................................ 10
   Editing Tools You Can’t Find Anywhere Else ...................................... 13
   Unique Special Effects ....................................................................... 18
   Graphic Tools To Personalize Your Productivity .................................. 21

5 | Corel Snapfire Plus SE ...................................................23

6 | Summary of New or Improved Features .....................25

7 | Customer Support and Other Resources ..................... 27
Introducing Corel® Paint Shop Pro® Photo XI

Corel® Paint Shop Pro® Photo XI continues the tradition of providing easy-to-use, professional-quality image-editing software at an affordable price. With the versatile new features and enhancements based on extensive user feedback, Corel Paint Shop Pro Photo is the perfect choice for everyone — from budding digital camera enthusiasts to professional photographers.

When we talked to our users, we learned that novices wanted to be able to correct their photos with one-step fixes. Photo hobbyists told us that they wanted to get right to work on image-editing and digital photo projects and learn about more advanced features as they progressed. Professionals said they wanted more advanced features that would give them unprecedented control when editing images. In response, Corel Paint Shop Pro Photo delivers new features and enhanced functionality that directly addresses these users’ needs.

Most Complete Digital Photography Toolkit

No other image-editing software offers so much to the entire spectrum of digital camera users. While Corel Paint Shop Pro Photo offers the simplicity needed by novices to give them impressive results immediately, it also has the power needed to satisfy the more complex requirements of the professional photographer. Whether users need to download images from a camera or share photos through e-mail, the Internet, or prints, Corel Paint Shop Pro Photo offers intuitive features that allow the beginner and expert alike to focus on creativity, not process. As users perfect their photos, they can easily use them in a wide variety of projects.

Easiest to Use

The learning curve for Corel Paint Shop Pro Photo is practically nonexistent thanks to the application’s Learning Center. New users with digital cameras don’t want to spend time learning a complicated application — they want to get working and see results right away. With award-winning learning tools, and an extensive collection of one-click fixes for common problems, users of all experience levels can get the job done quickly and effortlessly. Corel Paint
Shop Pro Photo also gives users the ability to automate the image-editing commands they use most often, saving them time and effort.

**Fastest Route to Professional Quality**

The ease of use that separates Corel Paint Shop Pro Photo from the competition doesn’t come at the expense of the total control for more sophisticated image editing that is demanded by professional photographers. For every one-click solution, there are also tools and features for manual fine-tuning, which are ideal for users with very specific image-editing and correction needs.

**Absolute Best Value**

Some might measure the value of software by what it costs; others might focus on what can be derived by using it. In either case, Corel Paint Shop Pro Photo XI offers the best value in image-editing software available today. It contains a complete digital photography toolkit, with which users can edit, share, and manage their photos and create special photo projects.

Based on user feedback, Corel Paint Shop Pro Photo has simplified the steps for the most common image-editing tasks, so that anyone can get to work within seconds of launching the application. Advanced users get all the professional-level tools and features usually found only in expensive image-editing applications.
Customer Profile

As the use of digital cameras has increased, Corel Paint Shop Pro Photo XI has kept pace to give digital photographers of all experience levels everything they need to edit, enhance, organize, and share their work. With its unique combination of straightforward tools, advanced photo-editing features, and groundbreaking learning resources, Corel Paint Shop Pro Photo XI lets users create impressive results immediately.

Corel Paint Shop Pro Photo XI also provides the breadth and depth of professional features to let users grow into the program as their curiosity and experience develop. It offers a range of time-saving features, including automatic and one-step fixes for some of the most common digital photo flaws. Instead of shackling creativity with steep learning curves and restrictive workflows, Corel Paint Shop Pro Photo gives the user total freedom to experiment and unlock the full potential of every photograph.

Photo Hobbyists

Photo hobbyists are serious about taking pictures and often have their camera at the ready to seize photo opportunities. They want simple tools that enable them to produce professional-quality images. Photo hobbyists like to experiment with new technologies and techniques, and they appreciate the ability to undo or redo an unlimited number of steps. Corel Paint Shop Pro Photo XI provides photographers of all skill and experience levels with tools that balance the efficiency of quick fixes with the power of precision photo-editing controls.

Photo Project Enthusiasts

More and more people are taking up digital photography, and they are seeing the creative possibilities that their digital images hold. After adjusting their images, many users want to add them to bigger projects.

Photo project enthusiasts take pictures mostly for pleasure and enjoy working on creative projects in their spare time. They often use photos or create graphics to add colorful imagery to their projects. With the recent
explosion in the field of digital camera technology, more people are exploring
the realm of digital arts and crafts. Corel Paint Shop Pro Photo lets users engage
in creative projects, such as scrapbooking, photo restoration, and image
enhancement. In addition, Corel Paint Shop Pro Photo includes an impressive
collection of graphics, templates, picture frames, and digital arts tools, so users
can personalize their projects with a wide range of simple creative.

Professional Photographers
Professional and semiprofessional photographers derive income from their
photography. They have exacting standards and won’t settle for anything less
than perfection in their photos. They are continually seeking new methods of
optimizing their photos. Although they don’t mind investing in new technology,
they don’t want software to interfere with their vision by locking them into a
particular work process. Busy professionals expect software to inspire them
creatively without adding time to their workflow. Corel Paint Shop Pro Photo XI
offers professional photographers a world of creative possibilities to explore and
an array of powerful, professional, yet easy-to-use tools that won’t slow them
down.

Office Workers
Office workers in a wide range of fields — from technical writers and architects
to real estate agents and legal professionals — are using graphics more than
ever in their day-to-day work. Images help them to communicate more
effectively by overcoming language barriers and clarifying ideas that text alone
can’t fully explain. They use graphics to improve their company’s image and
leave a lasting impression with customers and employees alike.

Corel Paint Shop Pro Photo XI includes a powerful image-editing toolset that’s
intuitive and easy-to-learn, so office workers can start using the application
immediately. Corel Paint Shop Pro Photo XI offers value-minded organizations
affordable and flexible licensing, easy deployment, compatibility with a wide
range of graphic file formats, and the power to customize the application to suit
their needs.
What’s Included with Corel Paint Shop Pro Photo XI?

Applications

• **Corel® Paint Shop Pro® Photo XI**: Based on user feedback, Corel® Paint Shop Pro® Photo XI is a complete digital photography toolkit, offering easy-to-use, professional-quality image-editing tools and features.

• **Corel® Snapfire™ Plus SE**: a 30-day preview of Corel Snapfire Plus features. After the 30-day preview, users can continue to use all the features found in Corel Snapfire, as well as an array of project templates to create a variety of eye-catching calendars, collages, certificates, and much more.

• **Getting Started with Corel Paint Shop Pro Photo XI**: two hours of video tutorials from lynda.com, a leading provider of training materials for renowned software products

Content

Corel Paint Shop Pro Photo XI provides hundreds of high-quality, easy-to-use creative extras, including

• **Picture Tubes™**: Click and paint with photos and creative pictures.

• **Picture Frames**: Easily add decorations and borders.

• **Photo Edges**: Apply a unique shape or a torn-edges look.

• **Patterns**: Paint with sophisticated colors and unique combinations; make your own backgrounds or scrapbook paper.

• **Textures**: Paint with any color, and then use a texture to add depth.

Printed Documentation

**Corel® Paint Shop Pro® Photo XI User Guide**: Corel Paint Shop Pro Photo XI includes an updated, 128-page user guide that describes common photo-fixing and image-enhancement workflows. The printed user guide mirrors the workflow outlined in the Learning Center to help users quickly master of the application.
Electronic Documentation

- **Help file**
- **Learning Center palette:** The Learning Center was designed to ensure that anyone can harness the power of advanced photo editing, regardless of their previous software experience. It builds user confidence by helping them complete tasks within seconds of launching Corel Paint Shop Pro Photo, resulting in higher levels of customer satisfaction and enjoyment from the software.
- **PDF version of the Corel® Paint Shop Pro® Photo XI User Guide**

Minimum System Requirements

- 500-MHz processor
- Windows® XP (SP2), Windows® 2000 (SP4)
- 256 MB of RAM
- 500 MB of free hard-disk space
- 1024 x 768 resolution display, 16-bit color
- Microsoft® Internet Explorer 6.0

Recommended System Configuration

- 1.0-GHz or faster processor
- Windows® XP (SP2)
- 512 MB of RAM
- 500 MB of free hard-disk space
- 1024 x 768 resolution display, 32-bit color
- Corel® WordPerfect MAIL™, Microsoft® Outlook®, Microsoft® Outlook® Express, or other MAPI-compliant e-mail software
- CD-R, CD-RW, DVD-R, or DVD+R burner
- Apple® QuickTime 7 player
- Microsoft® DirectX™ 9

WordPerfect MAIL is a powerful e-mail client with lightning-fast searching and RSS feeds.
Corel Paint Shop Pro Photo XI carries on where the last version left off by offering affordable, powerful, professional-grade tools and features. Photo enthusiasts — ranging from professional photographers to digital camera newcomers — can take their projects to a higher level with a toolset that yields astonishing results yet is easy to learn.

**Photo Organization Built Right In**

There’s much more to Corel Paint Shop Pro Photo than powerful image-editing tools and features. It’s a multi-faceted digital photography suite that lets users effortlessly import, organize, and share their photos with the built-in Organizer.

**New! Organizer:** This one-stop photo management center takes the guesswork out of finding photos stored on a computer. Users can search for images by filename, date, file type, or folder location. Thumbnail zooming makes finding a particular image even easier and faster. The ability to assign keywords, ratings, and other information to an image gives users even more ways to search for photos. The Organizer is customizable, so users have several options for integrating it into their workflow. In addition, EXIF-data editing and the ability to play and extract frames from video files make the Organizer an essential, time-saving tool for hobbyists and professionals alike.

**Give it a try**

**Browsing your PC for photos**

1. Press **Ctrl + B** to open the Organizer.
2. On the Organizer toolbar, click the **Find Photos** button.
3. In the Search dialog box, select one of the following from the **Find photos that match** drop-list:
   - **All** — searches for images that match all of the selected rules
   - **Any** — searches for images that match any of the selected rules
4. From the left drop-list, select from among following first set of search rules:
The Organizer is a one-stop photo-management center.

**New! Quick Review:** Using slide shows is a great way to share photos, and the Quick Review feature makes it simple to manage slide shows. Not only can users preview a slide show, they can use Quick Review to apply a quick fix to a slide, set a rating for a slide, add captions, and rotate images in a slide show.

**New! Photo Trays:** Photo Trays let users gather photos from various folders and then e-mail, print, or upload the gathered photos.

**New! Image Information Panel:** Corel Paint Shop Pro Photo gives users quick and easy access to key information about their photos in the Image
Information panel. Users can also rate their photos, as well as add keywords and dates to facilitate image searching.

**New! Photo Downloader:** When users of Corel Paint Shop Pro Photo XI or Corel Snapfire Plus SE plug devices such as cameras or card readers into their computers, the Corel Photo Downloader can automatically download photos. Corel Photo Downloader remembers which photos have already been downloaded, and users can easily view their most recent downloads. What’s more, the user can instruct the Corel Photo Downloader to perform the download automatically when a camera or memory card is inserted, creating a no-click, hassle-free download.

![Corel Photo Downloader Options](image)

**Corel Photo Downloader can automatically download photos when users plug a digital camera into their computer.**

**Enhanced! E-mailing:** Sharing images and photo projects has never been easier. Users can e-mail photos, slide shows, and video clips as embedded files or attachments. A preview allows users to double-check images before they’re sent, and Corel Paint Shop Pro Photo keeps a running count on the size of the selected files.

![Enhanced e-mailing makes sharing photos easier than ever.](image)
Essential Photo Tools For Everyday Jobs

Corel Paint Shop Pro Photo is renowned for being user-friendly, and that’s because user feedback has always played a huge role in the program’s development. From requesting one-click automatic fixes that take the guesswork out of image correction to insisting on advanced tools to meet the exacting standards in digital photography, the user has spoken, and Corel Paint Shop Pro Photo has responded.

**Enhanced! Crop Tool:** In response to user feedback, the Crop tool has been enhanced to give users the exact dimensions they want in a snap. When the user selects an area of an image with the Crop tool, a floating toolbar appears below the selected area, allowing them to choose a predefined crop size or to rotate the selected crop area.

The new floating Crop toolbar takes the guesswork out of image cropping.

**One-Step Fixes:** Corel Paint Shop Pro Photo XI has several features that allow an image to be analyzed automatically and corrected with a single click. The One Step Photo Fix command automatically adjusts the color balance, contrast, clarity, and saturation of an image. The One Step Purple Fringe Fix command gets rid of the purple glow that sometimes appears around edges of objects under certain lighting conditions. The One Step Noise Removal command identifies and eliminates the excess “noise” artifacts that are often seen in digital photos.

**Smart Photo Fix:** The Smart Photo Fix analyzes a photo and suggests settings for auto-corrections of color, brightness, sharpness, and saturation — all in one step. Completely flexible, users can apply the one-click fix or experiment further by manually fine-tuning the settings. At any point, if users decide that they prefer the results of the initially suggested fix, they can quickly reapply the suggested settings. Corel Paint Shop Pro Photo XI gives users the flexibility to experiment freely with confidence, knowing that they can always revert to their starting point.
Enhanced! Curves and Levels Dialog Boxes: The Curves and Levels features in Corel Paint Shop Pro Photo XI are controls that you’d expect to find only in complicated, high-priced image-editing software. The Curves and Levels dialog boxes have been overhauled to give users exceptional control over some of the most critical imaging adjustments. The Curves and Levels dialog boxes now have a histogram and improved rendering, so professional photographers can easily and intuitively fine-tune their work. Less-experienced users can use the three new automatic settings to optimize the contrast and color levels in their images with a few clicks.

Red Eye Tool: One of the most common problems in photos is red-eye, but Corel Paint Shop Pro Photo offers an easy solution. Users can quickly zap red-eye from their photos with the click of a button by using the Red Eye tool.
The Red Eye Tool helps users salvage great photos.

**Clone Tool:** The Clone tool lets users cover flaws in their photos by copying detail from a neighboring area. Users simply choose a source location and then draw over the flawed area of their image. The flaw is replaced with detail from the source location.

**Versatile Image Rotation:** The JPEG file format is one of the most widely used among photographers, digital artists, and photo hobbyists. In many image-editing applications, rotating a JPEG photo reduces image quality due to the recompression of the image. Corel Paint Shop Pro Photo offer users 90-degree rotation without decompressing and recompressing the photo.

**High Pass Filter:** Corel Paint Shop Pro Photo XI offers the High Pass Filter, a new sharpening option that yields better results than the standard Unsharp Mask filter.

**Lens Correction Filters:** Corel Paint Shop Pro Photo provides excellent Lens Correction filters that help users correct common photo distortions, such as fish-eye, barrel, and pincushion.

**16-Bit Editing:** Corel Paint Shop Pro Photo supports 16-bit functionality, which allows photographers to work with thousands of shades for each of the three color channels — red, green, and blue — in their images. This functionality gives users a far greater level of image-editing control compared with the 8-bit limit of 256 shades.

**Lighting Correction Features:** Sometimes a photo taken to capture a special moment is either overexposed or underexposed. Corel Paint Shop Pro Photo ensures that those photos can be corrected and salvaged with two great exposure-correction features — Fill Flash and Backlighting. The Fill Flash feature
allows users to correct the darker, underexposed areas. The Backlighting feature does the same with bright, overexposed areas of a photo.

**Enhanced! Raw Camera File Support:** Users can open and edit raw files from leading digital cameras.

**Color Management:** The Color Management engine lets users read and save color profile data in their files, which ensures that on-screen colors match printed colors. In addition, Corel Paint Shop Pro Photo supports CMYK input and output for commercial printers.

**Adjustment Layers:** Whenever a tonal or color change is applied to an image, the image’s information is altered, which means that the image ultimately starts to degrade. Advanced users love working with adjustment layers in Corel Paint Shop Pro Photo because they offer a great way to adjust the color or tone of underlying layers without modifying the pixels in the layer directly. In addition, users can add adjustment layers to test various color corrections or to see how several corrections look when they’re combined.

**New! Video File Preview:** Users can now make the most of video clips. Corel Paint Shop Pro Photo XI lets users preview and extract frames from video clips.

**Editing Tools You Can’t Find Anywhere Else**

Corel Paint Shop Pro Photo has a powerful toolset that can fix virtually any digital photo imperfection. If the problem stems from the quality of the image produced by the camera, users will find a series of tools that offer easy, quick corrections. Or, if photo subjects don’t look their best in the photo, Corel Paint Shop Pro Photo can spruce up their appearance.

**New! Color Changer Tool:** The Color Changer tool lets users easily change colors in their digital images to achieve more realistic colors. Rather than simply replacing a color, the Color Changer tool detects and analyzes variations in brightness caused by real-world illumination and reapply the illumination to
the new color to produce a realistic effect.

### Give it a try

**Recoloring image areas**

1. From the Tools toolbar, choose the Color Changer tool.
   - You may want to create a selection before you choose the Color Changer tool. Creating a selection may improve the results if the area to be recolored is a specific component, such as an article of clothing, or a single color that appears elsewhere in the image. You can use one of the selection tools to select the object or region to be recolored.

2. Position the Color Changer cursor over the color you wish to change, and then left-click to recolor with the Foreground/Stroke color on the Materials palette.
   - If the Materials palette is not displayed, choose View ▸ Palettes ▸ Materials.

3. To determine how closely the current color needs to match similar colors in order for the recoloring to be applied, adjust the Tolerance setting in the Tool Options palette.

4. To determine how pixels bordering the recolored pixels are affected, adjust the Edge Softness setting in the Tool Options palette.

---

One click can change this man’s shirt from beige to light blue.

**New! Depth of Field Effect:** Corel Paint Shop Pro Photo XI lets users draw attention to a specific area of an image. The new Depth of Field effect lets users apply focus to a region of a photo while applying an out-of-focus blur to the rest of the image. This allows users to easily replicate the look of the depth of field found in high-end cameras.

### Give it a try

**Applying focus to an area of a photo**

1. Choose Adjust ▸ Depth of Field.
**New! Skin Smoothing:** Digital photographers can quickly and easily even out the skin tone of people in their photos with the new Skin Smoothing feature. A preview of the change lets users choose how much smoothing to apply, so photo subjects always come across in the best light possible.

**Give it a try**

1. Choose Adjust > Skin Smoothing.
2. In the Skin Smoothing dialog box, adjust the Amount slider.

**Give it a try**

2. In the Depth of Field dialog box, choose one of the following Area of Focus selection tools, and drag in the Before pane.
   - **Circular** — lets you create a round selection
   - **Freehand** — lets you create an irregularly shaped selection by dragging around an area to create a closed shape
   - **Rectangular** — lets you create a rectangular selection
3. Move the Blur slider to adjust the amount of blur applied to the area outside the selection.
4. To adjust the pattern of the blurred area, click the Round Aperture Shape or Hexagon Aperture Shape button.
5. To adjust the transition between the area in focus and the blurred area, move the Feather slider.
Users can apply Skin Smoothing to make the subjects of their photos look their best.

**Makeover Tools:** Many photos are taken at special occasions where everyone wants to put their best face forward. To that end, Corel Paint Shop Pro Photo includes Makeover tools that let users quickly and easily touch up the subjects in their photos. These professional-strength tools include the Blemish Remover, the Teeth Whitener, and the Suntan Brush.

![Makeup Tools](image)

*Before*  
*After*

The **Makeover Tools** let users remove blemishes, whiten teeth, and apply a sun tan to photo subjects.

**Perspective Correction Tool:** With the Perspective Correction tool, users can fix buildings, landmarks, or objects in their photos that appear in the wrong perspective or that were taken from an angle other than directly in front.
**New! Corel Painter & Corel Painter Essentials Compatibility:**
Corel® Painter™ and Corel® Painter™ Essentials are renowned among digital artists, photo hobbyists, and professional photographers for their amazing ability to simulate a wide range of art tools. Corel Paint Shop Pro Photo XI now supports RIFF files, the native file format for both Corel Painter and Corel Painter Essentials. Users can open and save images as RIFF files to create a seamless workflow with the world's most popular painting and illustration software.

**Scripting:** Users can save tremendous amounts of time with the scripting features of Corel Paint Shop Pro Photo, especially when working with batches of images. Users simply record a series of commands and then play them back to apply the same effect or enhancement to an image or batch of images.

**Scratch Remover Tool:** The Scratch Remover tool instantly removes scratches, power lines, telephone poles, and other linear flaws or distractions in photos. This tool is particularly useful for removing scratches or cracks when users are restoring old photos.

**Object Remover:** If the only thing that stands between a good photo and a perfect one is an unwanted element — a lamp post, a tree, even a bystander — the Object Remover can help. The Object Remover makes it easy to remove
unwanted or difficult-to-clone portions of images and fills in the removed detail with portions of the remaining photo.

![Before](image1) ![After](image2)

**Unique Special Effects**

Corel Paint Shop Pro Photo offers an array of graphics tools and creative effects that help users transform their photos into something truly unique. While it’s fun to correct the color and adjust the objects in photos, there’s much more that users can do with Corel Paint Shop Pro Photo. From making a photo look like it was taken in long ago, using a bygone era’s film and camera technology, to adding stunning artistic effects, Corel Paint Shop Pro Photo provides the tools to unleash a user’s creativity.

**New! Time Machine:** The new Time Machine offers users a tour of photographic history by letting them see what their photos would look like if they were taken in another era. With a range of settings based on photo styles from the 1830s to the 1980s, users can easily send their photos back in time. A live preview lets users see the evolution of photography on a single image.

**Give it a try**

**Creating a vintage-style photo**


2. In the Time Machine dialog box, click one of the following thumbnails above the timeline to choose an effect:
   - **Daguerreotype** — Widely used from 1839 to 1855, daguerreotypes are often characterized by their reflective quality, a darkening at the edges, and a dark blue-gray or brown-black color.
   - **Albumen** — Widely used from 1855 to the 1890s, albumen photos are often characterized by their glossy finish, and soft, warm, brown tones.
   - **Cyanotype** — Invented in 1841, cyanotypes are characterized by their brilliant blue color.
   - **Platinum** — Popular from 1873 to 1920, platinum prints are often characterized by their wide tonal range and silvery-black colors.
**Give it a try**

- **Box Camera** — Box cameras were popular from 1900 to the 1960s. The simplicity and portability of the camera allowed anyone to take photos.
- **Early Color** — Autochrome was a popular method of producing early color photographs, which were characterized by soft colors and a slightly grainy quality.
- **Cross Process** — Cross-processing is a modern photography technique that creates unique color effects and is characterized by skewed colors, high saturation, and extreme highlights.

3 Move the **Intensity** slider to adjust the appearance of the effect.
4 To add edge effects for photos, mark the **Photo Edges** check box.

---

**Users can send their photos back in time.**

**New! Film and Filters**: Corel Paint Shop Pro Photo XI offers users a range of effects inspired by classic film and filter types. Users can experiment with a variety of film-effect and filter-effect combinations to produce interesting, eye-catching results. Users can also simulate the effect of using color filters on the lens of a camera by applying a Creative Filter effect, or they can apply a Film Look to simulate the effect of using different types of film in a traditional camera.

---

**Give it a try**

**Experimenting with film and filter effects**

1 Choose **Effects → Photo Effects → Film and Filters**.
2 In the Film and Filters dialog box, choose one of the following film types from the **Film Looks** drop-list:
   - **Vivid** — increases the saturation and contrast in a photo to make the colors more vivid
   - **Vivid Skin Tones** — ideal for portraits; warms skin tones
   - **Muted Reds** — makes reds more subtle
   - **Enhanced Reds** — emphasizes reds
   - **Vibrant Foliage** — ideal for landscapes; enhances blues and greens
Users can experiment with a variety of film and filter effects.

**Warp Brush Tool:** The Warp Brush tool lets users create caricatures of their photos or photo subjects by distorting the pixels in a particular area of the photo.

---

**Give it a try**

- **Warm Earth Tones** — ideal for landscapes; enhances reds, oranges, and yellows
- **Glamour** — ideal for portraits; creates a soft glow

3. Choose one of the following filter types from the **Creative Filters** drop-list:
   - **Night Effect** — applies a dark blue filter to make a photo look like it was taken at dusk or in moonlight
   - **Cooling** — cools image colors
   - **Warming** — warms image colors
   - **Orange** — warms image colors
   - **Champagne** — subtly warms image colors
   - **Sunset** — simulates the orange-red lighting effect that occurs at sunset
   - **Custom** — lets users choose a filter color by clicking the **Filter Color** swatch and choosing a color from the Color dialog box

4. To adjust the amount of color applied by a filter, type a value in the **Density** box.

5. Click **OK**.
**Black & White and Infrared effects:** With Black & White and Infrared filters, users can control the contrast strength and adjust the grain level of their photos to simulate real black-and-white, and infrared film.

Users can get creative with a Black & White and Infrared effects.

**Motion Blur:** Users can apply the Motion Blur command to a photo to create the illusion that the photo was taken while the subject was in motion.

**Graphic Tools To Personalize Your Productivity**

Corel Paint Shop Pro Photo XI lets users enhance images with a variety of tools that allow them to add their own personal touches. From text to eye-catching objects to unique borders, Corel Paint Shop Pro Photo helps users take their images to another level of creativity.

**Text Tool:** Using the Text tool, users can add descriptive or decorative text to an image. Users can modify text with the common formatting options that they would find in a word processor.

**Picture Tubes™:** A longtime user favorite, the Picture Tube tool lets users paint on their photos with a collection of professionally designed artistic elements. For example, users can add butterflies and beetles to a picnic setting, fill an aquarium with fish, or frame a picture with holly. Picture Tubes™ are available in a variety of themes, and users can also create their own graphics to use with the Picture Tube tool.

**Picture Frames:** Using picture frames is an easy way to add an eye-catching final touch to an image with picture frames and photo edges. Corel Paint Shop Pro Photo provides a variety of picture frame styles, and the frames are editable, so users can tweak them or create their own.

Picture Frames and Picture Tubes are a great way for users to get creative with their photos.
Corel® Snapfire™ Plus SE offers users a series of great image-editing, photo-management tools, and creative photo-project templates that in tandem with Corel Paint Shop Pro Photo help them import, edit, and share their images. With Corel Paint Shop Pro Photo XI, users receive a 30-day preview of Corel Snapfire Plus features. After the 30-day preview, users can continue to use all the features found in Corel Snapfire, as well as an array of project templates to create a variety of eye-catching calendars, collages, certificates, and much more.

Corel Snapfire Plus offers users easy-to-use image-editing tools, intuitive photo-management features, and a great selection of photo-project templates.

**New! Photo Doctor:** The Photo Doctor removes the guesswork from image correction by analyzing a digital image and recommending when Quick Fix should be applied. With a single click, users can then put the Photo
Doctor to work so that color balance, contrast, clarity, and saturation are adjusted to optimal levels using the One Step Photo Fix feature.

**Give it a try**

**Automatically optimizing photos**

1. Open a photo.
2. In the **Enhance** mode of the Tasks Panel, click **Quick Fix** when an information icon appears next to Quick Fix.
3. To read the Photo Doctor message, position the cursor over the information icon to display the message.

**Simple Photo Projects:** Corel Snapfire Plus SE includes many creative templates designed to inspire you to do more with your photos. With drag-and-drop simplicity, you can easily create stunning album pages, greeting cards, calendars, and collages.

*Users can easily create a variety of photo projects.*
Summary of New and Improved Features

Corel® Paint Shop Pro® Photo XI

- The Organizer is a built-in, one-stop photo-management center that takes the guesswork out of finding photos on the computer. Users can search for images by filename, date, file type, or folder location.
- The Color Changer tool lets users easily replace change colors in their digital images.
- The Time Machine lets users see what their photos would look like if they had been taken in an earlier era.
- The Film and Filters feature lets users apply effects to images to make it look like it was taken with a variety of film and filter types.
- The Depth of Field effect lets users apply focus to a region of a photo while applying an out-of-focus blur to the rest of the image, replicating the depth-of-field effect produced by high-end cameras.
- Skin Smoothing lets users remove any wrinkles, blemishes, or scars from the people in their photos.
- The enhanced Curves and Levels dialog boxes give users exceptional control over some of the most critical image adjustments, such as contrast, color, and levels.
- Video preview lets users preview, open, organize, and extract frames video files.
- The enhanced Crop tool lets users quickly and easily crop an image to a specific size.
- Corel® Painter™ and Corel® Painter™ Essentials compatibility allows users to open and save images as RIFF files to create a seamless workflow with the world’s most popular painting and illustration software.

Corel® Snapfire™ Plus SE

- Corel Photo Downloader automatically downloads photos whenever a user plugs a camera or card reader into their computer, giving them a thumbnail of each image on the device so that they can choose which images to import.
• The **Photo Doctor** removes the guesswork from image correction by analyzing a digital image and recommending any necessary changes.

• Corel® Snapfire™ Plus SE lets users create impressive, eye-catching *slide shows* from their photos and video clips.

• Corel Snapfire Plus SE includes many **creative photo project templates** designed to inspire users to do more with their photos. With drag-and-drop simplicity, users can easily create stunning album pages, greeting cards, calendars, and collages.
Customer Support and Other Resources

Corel provides a multi-tiered offering of support options for our business and graphics applications designed to accommodate consumer, small business and corporate customers. Additional information about global availability of our support services is located on the Corel web site at: www.corel.com/support.

Free Support
Available 24 hours a day, 7 days a week, 365 days a year, the Corel Knowledge Base provides free and unlimited support for all registered users of Corel’s retail and licensed software. This searchable Web-based tool provides answers to commonly asked technical questions. Responses are searchable in seven languages, including English, French, German, Italian, Spanish, Portuguese, and Japanese. To search the Corel Knowledge Base, please visit: www.corel.com/knowledgebase.

Warranty Support
Corel’s Warranty Support is designed to help customers with technical issues related to installation and product defects, including crashes and errors caused by the Corel software. Our Support Services can provide you with prompt and accurate information about product features, specifications, pricing, availability, services, and technical support. For the most current information on available support and professional services for your Corel product, please visit www.corel.com/support.

Personal Telephone Support
Many customers choose to speak directly to a Corel support technician over the telephone. Live person-to-person support provided on a toll-free line and is designed for individual, small business, academic, trial version, and OEM users.

A support incident is the resolution of one technical question, problem or issue, regardless of the number of telephone calls required to resolve it, and includes assistance with How-To's applied to a sample document (we can
show you how the feature works, but not how to implement the feature within your file), troubleshooting technical issues and documents, installation, configuration and setup (stand-alone), migration from one version to another.

**Enterprise Level Support**

Designed for corporate clients who require account management services and access to Corel’s most skilled support personnel. This enhanced level of support is selected by organizations that employ dedicated support professionals, have centralized technical management, or require specialized support. Corel’s experienced support team of specialists deliver high-quality support and provide the resources necessary to maintain a mission-critical environment. Needs for your entire enterprise are addressed from integration issues, open document management API (ODMA), network configuration, thin-client platforms, large-scale network application roll outs and in-house developer requirements.

**Professional Services**

The Corel Professional Services team builds solutions for international market leaders in government and Fortune 1000 organizations, including aerospace, defense, manufacturing, utilities, retail, and financial services. Our expertise resides in deploying new technology solutions, software deployment, application automation and third party integration support, solution sets, and training.

**Partnership Program**

Designed with maximum flexibility to meet the needs of diverse range of partners, the Corel Partner Program offers unparalleled tools and support, including the ultimate information resource, Corel® Connected.

**Zoom-In Newsletter**

A must-have for digital camera owners, this free monthly newsletter provides tutorials, quick tips, links to free content downloads, and user profiles that illustrate how people just like you are using Corel digital imaging software to create and share with their photos.
About Corel

Corel is a leading global packaged software company with an estimated installed base of more than 40 million users. The company provides high-quality, affordable, and easy-to-use productivity, graphics, and digital imaging software and enjoys a favorable market position among value-conscious consumers and small businesses. Corel’s product portfolio features well-established, globally recognized brands, including CorelDRAW® Graphics Suite, Corel® WordPerfect® Office, WinZip®, Corel® Paint Shop Pro®, and Corel Painter™. Headquartered in Ottawa, Canada, Corel Corporation is traded on The NASDAQ Stock Market® under the symbol CREL and on the Toronto Stock Exchange under the symbol CRE. For more information, please visit www.corel.com.
Media Contact North America
Gail Scibelli
PR Manager, Digital Imaging
Corel Corporation
613-728-0826 Ext. 5217
gail.scibelli@corel.com

Media Contact EMEA & APAC
Deborah Thomas
PR Manager, EMEA & APAC
Corel UK Limited
+44 (0) 1628 589850
deborah.thomas@corel.com

Corel Corporation
1600 Carling Ave.
Ottawa, ON
Canada K1Z 8R7

Corel UK Limited
Sapphire Court
Bell Street
Maidenhead
Berkshire SL6 1BU
United Kingdom

Corel Minneapolis
Paint Shop Pro
7905 Fuller Road
Eden Prairie, MN
55344 USA

Printed in Canada